CoolPack tutorial

For CoolPack version 1.49

Morten Juel Skovrup, Bjarne Dindler Rasmussen,

Arne Jakobsen, Simon Engedal Andersen

03-07-2011
## Exercise 15: Transient cooling of goods in a refrigerated room

- Suggested solution

## Exercise 14: Cooling demand for cold room

- Suggested solution

## Exercise 13: Air cooler

- Suggested solution

## Exercise 12: Gas flow in pipes (pressure drop and heat transfer)

- Suggested solution

## Exercise 11: Liquid flow in pipes (pressure drop and heat transfer)

- Suggested solution

## Exercise 10: Two-stage cycle with liquid injection

- Suggested solution

## Exercise 9: Two one-stage cycles

- Suggested solution

## Exercise 8: One-stage cycle with flooded evaporator

- Suggested solution

## Exercise 7: One-stage cycle with dry expansion evaporator

- Suggested solution

## Exercise 6: Creation of property plots and drawing refrigeration cycles

- Suggested solution

## Exercise 5: Short Refrigeration Utilities exercise

- Suggested solution

## Exercise 4: Short EESCoolTools exercise

- Suggested solution

## Exercise 3: Fundamental concepts in Refrigeration Utilities

- Suggested solution

## Exercise 2: Fundamental concepts in EESCoolTools

- Suggested solution

## Exercise 1: Fundamental concepts in CoolPack

- Suggested solution

## Overview of exercises in this tutorial

<table>
<thead>
<tr>
<th>Exercise</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fundamental concepts in CoolPack</td>
</tr>
<tr>
<td>2</td>
<td>Fundamental concepts in EESCoolTools</td>
</tr>
<tr>
<td>3</td>
<td>Fundamental concepts in Refrigeration Utilities</td>
</tr>
<tr>
<td>4</td>
<td>Short EESCoolTools exercise</td>
</tr>
<tr>
<td>5</td>
<td>Short Refrigeration Utilities exercise</td>
</tr>
<tr>
<td>6</td>
<td>Creation of property plots and drawing refrigeration cycles</td>
</tr>
<tr>
<td>7</td>
<td>One-stage cycle with dry expansion evaporator</td>
</tr>
<tr>
<td>8</td>
<td>One-stage cycle with flooded evaporator</td>
</tr>
<tr>
<td>9</td>
<td>Two one-stage cycles</td>
</tr>
<tr>
<td>10</td>
<td>Two-stage cycle with liquid injection</td>
</tr>
<tr>
<td>11</td>
<td>Liquid flow in pipes (pressure drop and heat transfer)</td>
</tr>
<tr>
<td>12</td>
<td>Gas flow in pipes (pressure drop and heat transfer)</td>
</tr>
<tr>
<td>13</td>
<td>Air cooler - Cooling and dehumidification of moist air</td>
</tr>
<tr>
<td>14</td>
<td>Cooling demand for cold room</td>
</tr>
<tr>
<td>15</td>
<td>Transient cooling of goods in a refrigerated room</td>
</tr>
</tbody>
</table>

## Concepts, shortcuts, and other hints
CoolPack tutorial

Concepts ........................................................................................................................................ 44
Screen ................................................................................................................................................ 44
EESCoolTools .................................................................................................................................... 44
Overview of programs in CoolPack .................................................................................................... 45
**Introduction**

This tutorial gives a general introduction to CoolPack and contains a number of exercises demonstrating how the programs in CoolPack should be used.

The exercises are organized in groups representing the various types of investigations for which CoolPack can be used. The first exercises are introductory, focussing on how to use the various types of programs in CoolPack and how to navigate between them. The following exercises are more detailed and aimed at demonstrating the use of CoolPack for analyzing refrigeration systems.

Once you have become familiar with the programs in CoolPack, we hope that you will use CoolPack for solving the refrigeration-oriented tasks related to your job/education. If you have any comments or questions about CoolPack we encourage you to contact us – your comments and ideas will be very helpful to us in making CoolPack an even better program.

**Description of CoolPack**

The development of CoolPack started in spring of 1998 as a part of a research project. The objective of this project was to develop simulation models to be used for energy optimization of refrigeration systems. The users of these models would be refrigeration technicians, engineers, students etc. in short all the persons with influence on the present and future energy consumption of refrigeration systems.

The first idea was to make a general and comprehensive simulation program that would give the user all the flexibility he/she could wish for in terms of handling many different system designs and investigation purposes. Some of the characteristics of very general and flexible programs are that they require many user inputs/selections and that their numerical robustness is rather low. Experience with this type of programs has shown that this type of simulation programs is far from ideal for the main part of the users mentioned above. Since most of these users have limited time for carrying out the investigation, general and comprehensive programs will in many cases be very ineffective to use and they are therefore often discarded by the users.

The idea behind the development of CoolPack is different from the idea described above. Instead of creating a large, general and comprehensive simulation program we have chosen to create a collection of small, easy to use, and numerically robust simulation programs.

The typical simulation program in CoolPack deals with only on type of refrigeration system and has a specific investigation purpose. It therefore only requires the user inputs/selections necessary to describe operating conditions etc. and not any inputs for describing the system design or for specifying the input/output structure associated with the simulation purpose.

When developing the programs for CoolPack we have focused on making the underlying system models as simple, relevant and numerically robust as possible. We have preserved some flexibility in that the user can select refrigerant and also specify inputs (like pressure) in more than one way (saturation temperature or pressure).
The programs in CoolPack covers the following simulation purposes:

- Calculation of refrigerant properties (property plots, thermodynamic & thermophysical data, refrigerant comparisons)
- Cycle analysis – e.g. comparison of one- and two-stage cycles
- System dimensioning – calculation of component sizes from general dimensioning criteria
- System simulation – calculation of operating conditions in a system with known components
- Evaluation of operation – evaluation of system efficiency and suggestions for reducing the energy consumption
- Component calculations – calculation of component efficiencies
- Transient simulation of cooling of an object – e.g. for evaluation of cooling down periods

To make it easier to get an overview of the programs in CoolPack we have chosen to divide the programs into three main groups (Refrigeration Utilities, EESCoolTools and Dynamic). Figure 2.1 gives an overview of the content in these groups.

**Figure 2.1:** Overview of the main groups in CoolPack.

The group **Refrigeration Utilities** consist of 3 refrigerant oriented programs, primarily used for calculating the properties of primary and secondary refrigerants, creating property plots for primary refrigerants (like p-h, T-s and h-s diagrams) and for calculating the pressure drop for flow of secondary refrigerants in pipes. Furthermore, it is possible to create property plots for humid air (psychrometric charts).

The programs in Refrigeration Utilities group have been released previously as independent programs. The first versions of the programs were released in 1996 and they have since then been expanded significantly with new refrigerants, more property plots etc. Apart from the built in property functions the current version can also use the very accurate property functions used in the RefProp program. If you have RefProp ver. 6.01 you will now be able to create high quality property plots based on RefProp data for refrigerants. See the on-line help in the programs.
The group **EESCoolTools** contains a large collection of programs for both refrigeration systems and components. We have chosen to divide this group into four subgroups as shown on Figure 2.2. The groups also represent the four phases of designing a refrigeration system.

The programs in these four groups have almost the same type of user interface, making it easier to combine their use and also use them for comparisons.

**The name EESCoolTools consists of the three words EES, Cool and Tools:**

- "**EES**" refers to the name of the program we have implemented our simulation models in (Engineering Equation Solver - EES). EES is developed by S.A. Klein and F.L. Alvarado, and is sold by F-Chart Software in Wisconsin, USA. You can get more information about EES and F-Chart Software on the Internet at [www.fchart.com](http://www.fchart.com)
- "**Cool**" refers to the fact, that the simulation models are related to the area of refrigeration.
- "**Tools**" refers to that the programs are thought to be tools enabling you to make faster and more consistent (energy) design and analysis.

---

**Figure 2.2:** EESCoolTool subgroups

The group named **Dynamic** contains the dynamic programs in CoolPack. So far only a single program is available. With this program it is possible to simulate the cooling down of an object/room under various conditions and with on/off-capacity control of the compressor.

**The dynamic element is modeled and solved using a DAE solver application called WinDALI. WinDALI is based on the DALI-program developed in 1985, at what at that time was called the Refrigeration Laboratory at the Technical University of Denmark (now a part of Department of Energy Engineering). The present version of WinDALI is freeware an is well documented. If you are interested in making your own**
dynamic simulation models, you are welcome to have a copy of WinDALI – all you have to do is to contact us.

The individual programs in CoolPack are described further in Chapter 6 of this tutorial.

CoolPack contact

CoolPack was developed as part of a research project called SysSim (an abbreviation for “Systematic Modeling and Simulation of Refrigeration Systems”). This project was financed by the Danish Energy Agency. The project administrator was Arne Jakobsen.

CoolPack is freeware and you are welcome to pass on your copy of the program to colleagues and friends. We encourage all who use CoolPack to register so that we can inform them about new versions and CoolPack-related arrangements.

The development of CoolPack is performed by Team CoolPack consisting of the following members:

<table>
<thead>
<tr>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arne Jakobsen</td>
</tr>
<tr>
<td>Bjarne Dindler Rasmussen</td>
</tr>
<tr>
<td>Morten Juel Skovrup</td>
</tr>
<tr>
<td>Simon Engedal Andersen</td>
</tr>
</tbody>
</table>
Installation

CoolPack will run under the following operating systems:

- Windows 95
- Windows 98
- Windows NT4.0
- Windows 2000 Professional
- Windows XP
- Windows 7

Your screen setting should be at least 16 bit color – if you choose 256 colors some of the background colors will appear “grumsy”.

If you downloaded CoolPack from the Internet you should have CoolPack in a single file called COOLPACK:EXE. This file is a self-extracting file containing the installation files. When you run this file its content will be expanded into a temporary folder (default is C:\TEMP). From this temporary folder start the file SETUP.EXE and the installation program will guide you through the installation procedure.

If you received CoolPack on CD-rom the installation should start automatically when the CD is inserted into the CD-drive. If this doesn’t happen you should start the file SETUP.EXE on the CD-rom. The installation program will guide you through the installation procedure.

Note #1: CoolPack and Windows 95:

If no icons appear in the CoolPack toolbars you should update your version of Windows 95.

If you received CoolPack on CD-rom you will find a folder called Win_Upd on this CD-rom. In this folder you will find a file 401COMUPD.EXE which contain the update files necessary. Run this file from CD-rom – the program will guide you through the update procedure. You will have to restart you PC before you can use CoolPack.

If you downloaded CoolPack from the Internet you can find the update files necessary on the following address www.et.dtu.dk/coolpack

Note #2: CoolPack and Windows 95/98:

On PC’s with Windows 95 or 98 the number of EESCoolTool programs that can be active at the same time is limited. The maximum number of active EESCoolTool programs depends on the available resources – typically only three EESCoolTools can be active on the same time. If you try to have more than three active EESCoolTools you might risk ending up in a situation where you get an error message like “The program has performed an illegal operation and will be shut down”. If this happens you should close some of the active (but not used) programs and try opening the requested program again.

For Windows NT4.0 and Windows 2000 Professional this limitation doesn’t exist.

The installation program will generate a shortcut to CoolPack so that you can start CoolPack via the START-button.
Exercises

Exercises 1, 2 and 3 introduce the various types of programs and demonstrate how to navigate in and between programs in CoolPack. Exercises 4 and 5 give a more detailed demonstration of the use of the models introduced in exercises 2 and 3.

Exercises numbered 6 and higher can be selected according to interest and preferences. These exercises are organized so that you will first find a description of the problem/exercise and on the following page you will find a suggested solution to the problem.

For some of the exercises you might not get the exact same results as stated in the solution. The problem might be "open"; meaning that you have to assume or evaluate temperatures and/or temperature differences as a part of the exercise. In these cases, you will probably not make the exact same assumptions as we have, and therefore the results you get might differ slightly from the suggested solution.

For exercise 9 you will need the separate appendix with printouts from catalogues.

Overview of exercises in this tutorial

**Introductory exercises**

1. Fundamental concepts in CoolPack
2. Fundamental concepts in EESCoolTools
3. Fundamental concepts in Refrigeration Utilities
4. Short EESCoolTools exercise
5. Short Refrigeration Utilities exercise

**Exercises for Refrigeration Utilities**

6. Creation of property plots and drawing refrigeration cycles

**Exercises for EESCoolTools – Cycle Analysis**

7. One-stage cycle with dry expansion evaporator
8. One-stage cycle with flooded evaporator
9. Two one-stage cycles
10. Two-stage cycle with liquid injection

**Exercises for EESCoolTools – Special investigations**

11. Liquid flow in pipes (pressure drop and heat transfer)
12. Gas flow in pipes (pressure drop and heat transfer)
13. Air cooler - Cooling and dehumidification of moist air
14. Cooling demand for cold room

**Exercises for Dynamic**

15. Transient cooling of goods in a refrigerated room
**Exercise 1: Fundamental concepts in CoolPack**

Start CoolPack as described in the Installation-section. When the program has started you will see a welcome screen with a short introduction to the main programs in CoolPack.

The programs in CoolPack are divided into three main groups: Refrigeration Utilities, EESCoolTools, and Dynamic. The main group EESCoolTools has been divided further into four subgroups: Cycle analysis, Design, Evaluation, and Auxiliary.

These six program groups each have a tab on the toolbar in the upper part of the screen, to the right of a group of buttons that control the appearance of this screen. By clicking on a tab the icons for the programs in this group will be shown on the toolbar. A program in a group is started by clicking (single click) on the program icon.

Figure 5.1 shows the icons for the three programs in the group Refrigeration Utilities. If you point the mouse on one of these icons (don’t click), you will see a small pop-up text with the title of the program.

![CoolPack interface and icons](image)

**Figure 5.1: Main screen in CoolPack**

When a program is started this main part of CoolPack will still be active, but it will be placed in the background. You will always be able to return to this window by clicking on its icon in the Windows Taskbar. You can several programs in CoolPack active at the same time. You can swap between active programs by pressing the ALT-key (holding it down) and also press the Tab-key.

When starting your second EESCoolTool you will receive a message saying that EES is already running and you will then be asked if you wish to open another copy. This message is just a precaution that should help
Windows 95 and 98 users in preventing the opening of too many EESCoolTools. If the PC runs low on resources like RAM opening many EESCoolTools may lead to the system becoming unstable.

**Exercise 2: Fundamental concepts in EESCoolTools**

*Start the first program in the group named "CoolTools: Cycle analysis" – the icon looks like this.*

All CoolTools start up in the main diagram window (in this case a stylistic log(p),h-diagram). This is shown on figure 5.2. In the upper left part of the screen you will see a column of function buttons – these can be used to start a calculation, save and load inputs to/from a file, or to access the on-line help-function. The help-function contains a description of the program and may also contain further diagrams.

In addition to the main diagram window a number of sub-diagram windows may exist. You can access sub-diagram windows by using the gray buttons in the left side of the screen.

![Image of EESCoolTool interface with marked function buttons and sub-diagram windows]

*Figure 5.2: Main diagram window for an EESCoolTool*

*Click on the button “Cycle Spec.”*

You will now see one of the sub-diagram windows in this program – figure 5.3 shows this window. In a sub-diagram window you will also find function buttons and navigation buttons for access to the other sub-diagram windows. You can access the main diagram window by clicking on the small button with the icon in the lower right part of the screen. Alternatively, you can also use the key combination Ctrl+D to return to the main diagram window.
The program you have opened is a program for analysis of refrigeration cycles (abbreviated C-Tool). In this type of tools all the primary inputs are gathered in the sub-diagram window with the title “Cycle Spec.” The inputs are grouped according to the phenomena they describe. Every group has a title giving the connection between the inputs and outputs found in this group. In Figure 5.3 you will see a group titled “Cycle Capacity” where the input for the capacity and the outputs related to capacity like mass and volume flow are found.

Inputs are marked as small boxes with green text/numbers on white background. There are two different types of inputs. The first type is the simple where numbers are entered from the keyboard. The second type contains a list of selectable inputs, typically selectable text items. The list will first appear when you click (single click) on the small gray button with the small black arrow. Figure 5.4 shows the drop-down list from which you can select the refrigerant. For long lists scroll bars will appear.

Try selecting R134a as refrigerant

Outputs (both text and numbers) are normally given in a dark blue color. If changes are made to the inputs, all output will change color to gray in order to indicate that the outputs on screen may no longer represent the solution to the inputs on screen. The change you made previously when selecting a new refrigerant caused all outputs to change color to gray.

A calculation is started by clicking on the function button labeled “CALC” or by pressing the F2-key.
Start calculations by clicking the “CALC” button or by pressing the F2 key.

A small window will appear informing you about the progress of the calculation process. As long as calculations are performed the button in this window will be labeled “Abort”. When a solution has been found the name will change to “Continue”. When you see the name change to “Continue” you have performed your first calculation in CoolPack – in this case you have calculated the main parameters and all state points in a one-stage refrigeration cycle – congratulations!!!

The current window contains a number of input boxes, where the values for typical cycle specification parameters can be entered. In the top part of the window the conditions for the evaporator and the condenser are specified. Below, a group of variables titled ”Cycle capacity” appears. The cycle capacity can be specified in several ways. The direct and most simple way is specifying the refrigeration capacity in [kW], but indirect ways of specifying the capacity using the mass flow in [kg/s] or volume flow in [m$^3$/h] of refrigerant is also possible. You choose between the different ways of specifying the capacity by selecting one of the text-options from the drop-down list. The default selection is “Ref. Capacity [kW]”. To the right of these inputs the values of the different variables specifying the cycle capacity are echoed.

Select the “Volume flow [m$^3$/h] :” option and type in a value of 15 in the input box to the right

Similarly to specifying the cycle capacity, other phenomena (like compressor performance, compressor heat loss and suction line superheat) can be specified in multiple ways. In all cases the specification variable is chosen from a drop-down list and the actual input value is entered in the input field to the right of the drop-down list. Please note that in most cases changing the input variable will require the input value to be changed also.

Calculate again (press F2 or click on the CALC button).

Inspect the new results

Try changing some of the other inputs and calculate again (try any combination of inputs you like…).

If you end up in a situation where you have specified one or more inputs to which no solution can be found, you can always close the model and reload it with default inputs. Either click on the small gray window close button (the one with the X) in the title bar of the main window or click on the “File”-menu. You will then see a list of commands – in the lower part you will se the names of other programs and the current program. Click on the name of the current program and the program will be reloaded with default inputs.

When you feel that you have become familiar with the use of this model you can return to the main diagram window. You can do this by either clicking on the small “Home” button in the lower left corner of the window or by pressing the “Ctrl” and “D” keys on the keyboard.

Go to the main diagram window

In most of the CoolTools more than one subdiagram window exist. You can open the other subdiagram windows by clicking on the gray buttons in the left side on the main diagram window.

Press the button ”State Points” to enter one of the other subdiagram windows.

The values of temperature, enthalpy, pressure and density at all state points are given in a table. The state point numbering can be seen either from the log(p),h-diagram in the main diagram window or from the pipe diagram found in the Help.
It is not necessary to return to the main diagram window to move from one subdiagram window to another. Use the gray buttons in the lower left part of the screen.

**Click on the gray button titled “Auxiliary”**

In the Auxiliary subdiagram window you can find information about the necessary dimensions of the main pipes in the system, you can calculate the compressor displacement required for the capacity you have specified (using a volumetric efficiency for the compressor) and you can calculate the possible heating of a flow of water in a desuperheater. Note the current results and try changing some of the inputs in this window – recalculate and evaluate the new results.

The main diagram window and all subdiagram windows can be printed. In the menu "File" choose "Print". Default print setting is to print only the main diagram window. If you want to print any of the subdiagram windows then you must deselect the item "Diagram" and re-select "Diagram" again. Then a menu appears from which you can choose to print one or more of the diagram windows in the program.

You can also copy the active (current) diagram to a word processor using the "Edit" menu, or by using the built in Windows possibility to make screen dumps using the Print Screen key (PrtScn). In a word processor you can insert the screen dump by pressing Ctrl + V.

From within a program there are shortcuts to other CoolTools related to the active CoolTool. Open the “File” menu and look at the list of Tool-names in the bottom part of the menu. Clicking one of these names will close the active tool and bring up this new tool directly. If you don’t want to start a new CoolTool but want another type of tool (or close CoolPack) choose “Exit” from the “File” menu or use the standard windows buttons in the upper right corner.

A list of all the shortcuts in CoolTools is given below.

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;F2&gt;</td>
<td>Solve model (calculate)</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;G&gt;</td>
<td>Update initial guesses</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;D&gt;</td>
<td>Return to main diagram</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;P&gt;</td>
<td>Go to Print-menu</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;Q&gt;</td>
<td>End program (quit)</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;C&gt;</td>
<td>Copy current diagram to clipboard</td>
</tr>
</tbody>
</table>
Overview of buttons:

<table>
<thead>
<tr>
<th>Description of function</th>
<th>Button and icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return to main diagram window</td>
<td>![home icon]</td>
</tr>
<tr>
<td>Calculate, corresponds to pressing the F2-key</td>
<td>![calc icon]</td>
</tr>
<tr>
<td>Save inputs in a file</td>
<td>![save icon]</td>
</tr>
<tr>
<td>Load inputs from a file</td>
<td>![load icon]</td>
</tr>
<tr>
<td>Activate the help-function</td>
<td>![help icon]</td>
</tr>
<tr>
<td>Go to sub-diagram window with cycle specification</td>
<td>Cycle Spec.</td>
</tr>
<tr>
<td>Go to sub-diagram window with auxiliary calculations</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>Go to sub-diagram windows with overview of state points</td>
<td>State Points</td>
</tr>
</tbody>
</table>
Exercise 3: Fundamental concepts in Refrigeration Utilities

Click on the Refrigeration Utilities tab in the main CoolPack window. You will see three icons. The first icon represents the main program in this group. The other two icons represent small and handy programs for calculation of specific properties for refrigerants and secondary fluids.

The main program in this group can be used to draw high quality property plots for a large number of refrigerants. Further, you can plot refrigeration cycles on these diagrams and have the program calculate enthalpy differences between state points, COP, etc. This program has so many features, especially when it comes to formatting of property plots, so that it is not practical to list them all in this introductory exercise. Please refer to the built-in help in the program for more information about its features and for help in general.

Start the program by clicking on the icon.

If you move the mouse pointer across the various buttons in the upper toolbar, then short descriptions will appear.

Click on the button to draw a log(p),h-diagram.

A list of refrigerants is then displayed.

Select R290 (propane) and click on the OK button.

Figure 5.5: Log(p),h-diagram in Refrigeration Utilities
A log(p),h-diagram of R290 is now being drawn using default values for formatting of the plot (number of curves for constant temperature, entropy, quality and specific volume and default values for line colors etc.) Notice, that as you move the mouse pointer around in the plot area the “thermodynamic” coordinates like pressure, temperature etc. of the mouse pointer position are displayed in the lower left corner. If you click the mouse button while the pointer is inside the plot area, the “thermodynamic” coordinates will be copied to a local clipboard. Use the “Options” menu, “Show log...” command to view the coordinates.

For refrigerant mixtures like the R400-series, calculating the refrigerant properties in the two-phase region takes more time than the calculations for a pure substance. Therefore, when you select a refrigerant mixture, like R404A, you will be prompted for selecting/deselecting lines of constant quality, entropy and temperature for the two-phase region. Deselecting the lines for constant entropy and quality speed up the calculation (and plotting) process significantly.

Having drawn a log(p),h-diagram, you can specify a refrigeration cycle and have the state points plotted on the diagram.

Choose the item “Input cycle” from the “Options” menu.

Currently, you can choose between four different refrigeration cycles. Choose “One-stage cycle”, and enter appropriate values for evaporation temperature and condensing temperature etc. Disregard the pressure drops etc. for now. Click on the “Update” button when done.

![Cycle input window](Figure 5.6: Cycle input window)

In the right part of the screen the values for the specific performance are shown.
Click on the “Show info” button.

In this window more information about the cycle is given and it is possible to specify the cycle capacity (either as cooling capacity, mass flow or power consumption, etc.) One and only one of these variables should be given. The values of the other variables are calculated automatically.

Figure 5.7: Dimensioning of a refrigeration cycle

Input a value for the cooling capacity (Qe) and click the “Update” button. Click the “OK” button to draw the cycle (state points) on the diagram. You can always inspect the specifications of the cycles you draw by choosing the “Show cycle info..” item from the “Options” menu. For comparison multiple cycles can be drawn in the same diagram. A list of useful shortcuts in Refrigeration Utilities is given below.

<table>
<thead>
<tr>
<th>Mouse</th>
<th>Keyboard</th>
<th>Keyboard + Mouse (Keyboard + Keyboard)</th>
<th>Shortcuts to menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click</td>
<td>Down, left, up, and right - arrows</td>
<td>&lt;Ctrl&gt; + left button (or space)</td>
<td>&lt;Ctrl&gt;&lt;S&gt;</td>
</tr>
<tr>
<td>Double-click below x-axis</td>
<td>&lt;Space&gt;</td>
<td>&lt;Shift&gt; + Left button (or space)</td>
<td>&lt;Ctrl&gt;&lt;C&gt;</td>
</tr>
<tr>
<td>Double-click to the left of the y-axis</td>
<td>&lt;Enter&gt;</td>
<td>&lt;Ctrl&gt; + &lt;Shift&gt; + Left button + Drag</td>
<td>&lt;Ctrl&gt;+&lt;C&gt;</td>
</tr>
<tr>
<td>Right-click</td>
<td>&lt;Esc&gt;</td>
<td>&lt;Alt&gt; + Right button below x-axis or left of y-axis</td>
<td>&lt;Alt&gt;+&lt;C&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;Alt&gt; + Left button + Drag</td>
<td>&lt;Ctrl&gt;+&lt;&lt;&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>&lt;Ctrl&gt;+&lt;&lt;&gt;</td>
</tr>
</tbody>
</table>

Double-click | Format selected text or curve |
Double-click below x-axis | Format x-axis |
Double-click to the left of the y-axis | Format y-axis |
Right-click | Stop drawing of polyline |
Down, left, up, and right - arrows | Move cursor |
<Space> | Just like a left mouse click |
<Enter> | Like double-click |
<Esc> | Stop drawing of polyline (like mouse right-click) |
<> on numeric keyboard | Increase step size using arrows |
<> on numeric keyboard | Decrease step size using arrows |
<Ctrl> + left button (or space) | Select curve |
<Shift> + Left button (or space) | Select text |
<Ctrl> + <Shift> + Left button + Drag | Move selected text |
<Alt> + Right button below x-axis or left of y-axis | Auto max-min coordinates on axis |
<Alt> + Left button + Drag | Select new max-min coordinates of axis |
<Ctrl>+<S> | Save plot |
<Ctrl>+<I> | Save picture |
<Ctrl>+<P> | Print |
<Ctrl>+<X> | End |
<Ctrl>+<C> | Select next curve-type being closest to the cursor position |
<Ctrl>+<<> | Copy to clipboard |
Exercise 4: Short EESCoolTools exercise

Specify the following one-stage cycle with dry a dry expansion evaporator. The evaporation temperature is –30.0 °C, the superheat is 10.0 K, the condensing temperature is 25.0 °C, the subcooling is 2.0 K, the refrigeration capacity is 100 kW, the isentropic efficiency is 0.7, the heat loss from the compressor is 7% and no useless superheat or pressure loss occur in the suction line. Pressure losses in the discharge line is likewise disregarded and no internal heat exchanger is present. The refrigerant is R134a.

1. What is the value of the COP?

Make the following changes: The heat ingress in the suction line is 1000 W, the mass flow rate is 0.4 kg/s, the heat loss from the compressor is 1.0 kW and the thermal efficiency of the internal heat exchanger is 0.4.

2. What is the pressure ratio (compressor outlet/inlet) and what is the new value of the COP?
Exercise 4: - Suggested solution

Use the CoolTool with the title “One stage system - Dry expansion evaporators”. You find it in the program group “CoolTools: Cycle analysis”.

It is represented by the following icon.

Enter the relevant values in the cycle-specification subdiagram window.

1. COP should be 2.451

2. Enter the new information. COP will then become 2.439. The pressure ratio is found in the subdiagram window “State points” and should be 7.863.
Exercise 5: Short Refrigeration Utilities exercise
An exercise in creating Log(p),h - diagrams

1. Draw a log(p),h-digram for the refrigerant R717 (ammonia)
2. On this diagram, draw a one-stage cycle using the following data:
   - Evaporation temperature = -35.0 °C
   - Superheat = 8.0 K
   - Isentropic efficiency = 0.7
   - Condensing temperature = 30 °C
   - Subcooling = 2 K
3. Does the cycle look OK? Check the discharge gas temperature...is it within acceptable limits?
Exercise 5: Suggested solution

Use the main Refrigeration Utilities program. You can find it in the program group “Refrigeration Utilities”.

It is represented by the following icon.

1) Choose the “File” menu and select the “New” item and then the “Log(p),h – diagram” option or click on the button. Select R717 and click the “OK” button.

2) To draw the cycle, choose “Options” and the “Input cycle” item, or click on the button. Type in the data specified and when done click the “Draw cycle” button.

3) The cycle is not realistic – the discharge gas temperature is above 200 °C (place the mouse pointer on the state point and look at the coordinates in the lower left corner). R717 (ammonia) is not a suitable refrigerant for a one-stage compression from –35 °C to 30 °C. Try drawing a log(p),h-diagram for R404A instead and then draw a new cycle with the same specifications. In this case the discharge gas temperature becomes only app. 65 °C. Try other refrigerants….which one will give the highest COP?
Exercise 6: Creation of property plots and drawing refrigeration cycles

Setting up the program preferences and drawing property plots

A) Program preferences
Add name, company, address, and phone number to program preferences

B) Log(p),h-diagrams
1. Draw a Log(p),h-diagram for R290 (propane)
2. Draw a one-stage refrigeration cycle with the following specifications:
   - Evaporating temperature = -20 °C
   - Superheat = 8 K
   - Pressure drop in evaporator = 1 K
   - Pressure drop in suction line = 1 K
   - Pressure drop in discharge line = 2 K
   - Isentropic efficiency = 0.7
   - Heat loss from compressor = 15 % of power consumption
   - Condensing temperature = 35 °C
   - Subcooling = 2 K
   - Pressure drop in condenser = 0.1 bar
   - Pressure drop in liquid line = 0.01 bar
3. Calculate the necessary displacement rate of the compressor if the refrigerating capacity is 100 kW (assume a volumetric efficiency of 0.85)
4. Copy the calculated results to a word processor (e.g. WordPad).
5. Delete the numbers on the isochores in the two-phase region
6. Add numbers to the state points in the refrigeration cycle
7. Copy the Log(p),h-diagram to a Word processor
8. Copy the refrigeration cycle to a Log(p),h-diagram for R22
9. Save the diagrams as plots
10. Save the diagrams as image

C) Mollier-diagrams (moist air)
1. Draw a Mollier diagram (I,x-diagram) for moist air at a pressure of 2 bar
2. Note the coordinates (I, x) for the following two state points (T,ϕ) = (25 °C, 70 %) and (T,ϕ) = (5 °C, 100 %)
3. Draw a line between the two state points
4. Print the diagram

D) Refrigerant calculator
1. Find the specific volume, specific enthalpy, and specific entropy of R407C on the dew-point curve at a temperature of −10 °C.
2. If the specific entropy is 1900 J/(kg·K) and the pressure is 4 bar and the refrigerant is R134a what is the specific enthalpy? (See the online help for solution method).

Hints and help
Use the on-line help
Read the document shown under Help – Version info.
Exercise 6: Suggested solution

Use the main Refrigeration Utilities program. You can find it in the program group “Refrigeration Utilities”. It is represented by the following icon.

A) Program preferences
   1. Choose File – Preferences and type in the information about name, company, etc. Remember to select which parts of the this information that should be included on the diagrams.

B) Log(p),h-diagram
   1. Choose File – New – Log(p),h-diagram or click on the button. Choose R290 (propane) and click on the OK-button.
   2. Choose Options – Input cycle or click on the button and type in the cycle specifications. Click on the Draw Cycle button.
   3. Choose Options – Show cycle info, type in 100 for the refrigeration capacity Q_e [kW] and a volumetric efficiency of 0.85. The compressor displacement rate necessary is calculated.
   4. Click on the Copy button and choose OK to include the coordinates of the state points. Click on OK to close this dialog. Start your word processor and choose paste (set the font to Courier New).
   5. Go back to the Refrigeration Utilities program. The isochores (and all other iso-lines) can be formatted in two different ways:
      i. Choose one curve of the curve types you want to format by holding the Ctrl-key down and clicking on this curve. Choose the menu Format – Selected curve type to format all curves of the same type as the selected. If you choose the menu Format – Curve only the selected curve will be formatted.
      ii. Choose the menu Format – Two-phase area – Isochores
   6. Choose Draw – Text and click on the diagram where you want the text to be placed. Repeat for all the other state point. The text can be moved by:
      i. Selecting the text by holding the Shift-key down and clicking on the text
      ii. Hold the Ctrl-key and the Shift-key down and drag the text with the mouse
   7. Choose Edit – Copy to clipboard, go to the word processor and choose paste
   8. Choose Options – Edit Cycle, click on the refrigeration cycle and click on the OK-button. Click on the Copy Cycle button and close the dialog by clicking on the Cancel button. Draw the new Log(p),h-diagram for R22, click on the button and choose Paste Cycle. The data for the refrigeration cycle has now been copied to the new Log(p),h-diagram. Click on Draw Cycle to view the cycle.
   9. Choose the menu File – Save plot
   10. Choose the menu File – Save Image

C) Moist air diagram
   1. Choose File – New – l,x-diagram or click on the button. Type in 2 for the Total pressure and click on OK.
   2. Locate the two state point by pointing with the mouse and read the coordinates in the lower right corner. When a point has be located click on it – this will save the coordinates in a log-file. The coordinates of the “clicked” points can be read/copied by choosing Options – Show log. This feature is also available in the other types of diagrams.
   3. There are two ways of doing this:
i. Choose the menu *Edit – Draw polyline*, click on the two points and right-click to terminate the command.

ii. Choose *Options - Input curve data* and type in the data for T and φ.

4. Print the diagram by clicking on the button.
Exercise 7: One-stage cycle with dry expansion evaporator
A new cold storage room is to be constructed. You have estimated the cooling demand to be approx. 15 kW. The dimensioning evaporation temperature is -6.0 °C and the superheat is controlled to be 5.0 K. The dimensioning condensing temperature is 35.0 °C and the subcooling is believed to be 2.0 K. At this stage pressure losses in pipes are disregarded and there is no suction gas heat exchanger. From experience you know that the isentropic efficiency of your compressor is approx. 0.7. The heat loss from the compressor can be estimated to be equal to 10 % of its power consumption.

1. Which of the following three refrigerants (R134a, R404A, R717) should be chosen if the criterion is maximum COP?
   Now you consider using a suction gas heat exchanger. Using catalog data you can estimate the thermal efficiency of the suction gas heat exchanger to be app. 0.3.

2. Which of the three refrigerants will now give the highest COP?
   You choose to continue your investigations using R134a and keeping the suction gas heat exchanger.

3. How high will COP become if \( T_C \) (the condensing temperature) is lowered by 5.0 K?

   So far the heat ingress in the suction line has been disregarded - but reasonable assumption is that a 5 K heat up in the suction line occurs (use \( T_C = 35.0 \) °C).

4. What will COP become in this case?

   Now you insulate the suction line so the heat ingress in this pipe can be disregarded.

5. What will COP become, when there are pressure losses in the suction line and the discharge line corresponding to 1.0 K in both lines?
Exercise 7: Suggested solution

Use the CoolTool with the title “One stage system - Dry expansion evaporators”. You find it in the program group “CoolTools: Cycle analysis”. It is represented by the following icon.

Enter the relevant values in the cycle-specification subdiagram window. Since no suction gas heat exchanger is used you must omit this component for the model. You can do this by specifying a thermal efficiency of 0 (zero) or by selecting “No SGHX”.

1. Perform the calculations selecting one of the three refrigerants – note the COP calculated. Repeat this for the other two refrigerants. R717 will have the highest COP of 3.831.
2. Type in a thermal efficiency of 0.3 for the suction gas heat exchanger. Now R134a will have the highest COP of 3.794.
3. Type in a condensing temperature of 30.0 °C. COP then becomes 4.444.
4. Type in the non-useful superheat specified. COP will drop to 3.703.
5. Type in the pressure losses and adjust the non-useful superheat back to 0.0 K. COP then become 3.596.
Exercise 8: One-stage cycle with flooded evaporator

A friend has given you an old ammonia compressor as a birthday present. On the birthday card is says that the isentropic efficiency has been determined to be 0.55. It further says that at an evaporating temperature ($T_E$) of $-5.0^\circ$C, a condensing temperature ($T_C$) of $35.0^\circ$C, and a subcooling of 2.0 K, the compressor will have a volume flow 100.0 m$^3$/h in the suction inlet. The superheat in this situation was probably 5.0 K.

You would like to use this compressor in a one-stage system with a flooded evaporator.

1. What can you expect in terms of COP and refrigerating capacity from this system? Assume no pressure drops in the suction and discharge lines. Assume further that the heat loss from this compressor is 10.0% of the power consumption.

2. If the circulation number for the refrigerant in the evaporator is 1.1 what will the mass flow in the evaporator?

   When thanking your friend for the birthday present he mentions that the heat loss from the compressor is probably a bit optimistic. Instead of using the 10 % heat loss stated on the card, you should use a value for the discharge gas temperature of 120 °C.

3. What is the heat loss of the compressor in terms of % of the power consumption and in kW if the temperature of the discharge gas is 120 °C?

   The results don’t seem right so you contact your friend again to discuss your results. He admits that the isentropic efficiency stated on the card is wrong, but he is very sure that the power consumption was 22.0 kW at the conditions mentioned on the card.

4. What is the isentropic efficiency if the power consumption is 22.0 kW?
Exercise 8: Suggested solution

Use the Tool "One stage cycle – Liquid overfeed evaporators". You find it in the program group “CoolTools: Cycle analysis”.

It is represented by the following icon.

Type in the values stated in the subdiagram window “Cycle Specifications”.

1. COP becomes 3.075 and the refrigerating capacity becomes 86.2 kW.
2. Enter the circulation number instead of the evaporator outlet quality and calculate. The circulating mass flow of refrigerant becomes 0.074 kg/s.
3. Enter the temperature of the discharge gas instead of the heat loss factor \( f_Q \). The heat loss becomes 28.9 % or 8.11 kW.
4. Enter the power consumption instead of the isentropic efficiency. The new isentropic efficiency becomes 0.7. This change also makes the heat loss of the compressor more realistic.
Exercise 9: Two one-stage cycles
A small supermarket has two separate one-stage refrigeration plants for low and medium temperature. They have been recommended to subcool the liquid in the low temperature system, using the medium temperature system.

The system has the following data:

- Cooling capacity: 3.0 kW low temperature and 5.0 kW high
- Evaporation temperature -35.0 °C for low temperature and -10.0 °C for high. Both with 5.0 K superheat.
- Condensing temperature is 30°C for low temperature and 35.0 °C for high. Both with subcooling of 2.0 K
- Pressure drop in all suction and discharge lines is 0.5 K and the non-useful superheat is 1.0 K.
- The isentropic efficiency is 0.7 for both compressors and the heat loss factor is 10%.
- There is an internal heat exchanger with an efficiency of 0.3.
- The refrigerant in both circuits is R404A

1. Will it improve the operation to add a subcooler with efficiency of 0.5?
2. Try to maximize the COP by just changing the refrigerant in the two cycles.
Exercise 9: Suggested solution

Use the Tool “Two separate cycles, subcooling of liquid for low temperature cycle”. You find it in the program group “CoolTools: Cycle analysis”.

It is represented by the following icon ![Icon](image)

Type in the values stated in the subdiagram window “Cycle Specifications”.

1. If superheat of 7.0 K is used then simulation without subcooler gives a COP of 2.311 and with subcooler 2.425 (i.e. an improvement of about 5%)
2. With R600a in low temperature and R290 in medium temperature, the COP becomes 2.646.
Exercise 10: Two-stage cycle with liquid injection

You are asked to evaluate COP for a two stage system with R717.

The system is made of two old separate on-stage compressors where the suction gas to the high pressure compressor is cooled by the injecting liquid in the suction line.

There is no special subcooling heat exchanger and there is no load at the intermediate pressure. Also there is no suction gas heat exchanger.

The idea is to change the two separate compressors with a new and efficient two-stage compressor and at the same time install a subcooling heat exchanger. But what will the improvement in COP be?

The cooling capacity is 155 kW at an evaporation temperature of –38 °C. The dimensioning condensing temperature can be estimated to 20 °C. The intermediate pressure is estimated to about ca. –15 °C.

The isentropic efficiency of the old compressors is 0.6 for both the high and the low pressure compressor.

The superheat is 5.0 K, the subcooling 1 K and the liquid injection is done so that the total superheat for the high stage compressor is 15 K.

There is no pressure drop in pipe lines and you can use default values for heat loss (10%) and non-useful superheat.

1. What is COP for the old system?

The system is modified so that:

- The old compressors are change to one new two-stage compressor. The volume ratio on the new compressor is 3, and the isentropic efficiency is 0.7 for both high and low pressure part of the compressor.
- A subcooling heat exchanger is installed. The efficiency is 0.5.

2. What is COP for the modified system?
Exercise 10: Suggested solution

Use the Tool “DX evaporators, liquid injection in suction line, one stage compressors”. You find it in the program group “CoolTools: Cycle analysis”.

It is represented by the following icon

Type in the values stated in the subdiagram window “Cycle Specifications”.

1. COP is 1.877. The total power consumption is 82.6 kW split between 32.7 kW to the low pressure compressor and 49.9 kW for the high pressure compressor. Note that to keep the total superheat in the suction line for the high pressure compressor at 15 K approx. 0.0184 kg/s of liquid has to be injected. The discharge temperature is at about 133 °C. The pressure ratio for the two compressors can be found in the sub-window ”State Points”. Here you can also see that the optimal intermediate pressure would have been –12.6 °C in this case.

For question 2 you should change the tool to “DX evaporators, liquid injection in suction line, two-stage compressor”.

Carefully enter the same values as before! The result will be that COP increase to 2.288, which correspond to an increase of about 22 %.

The total power consumption has dropped to 67.8 kW split between 36.1 kW for low pressure and 31.7 kW for high pressure.

Note that to keep the total superheat in the suction line for the high pressure compressor at 15 K approx. 0.0213 kg/s of liquid has to be injected, which is slightly more than before! The reason is that the intermediate pressure is at –6.9 °C, which means that the low pressure part of the two-stage compressor is working at a higher pressure ratio than the old compressor – so more liquid is needed to keep the superheat low (sketch the two situations in a log(p)-h diagram). The discharge temperature can now be kept at approx. 93 °C.

The subcooler transfers 8.1 kW (look in main window – Q₄₋₇) and the liquid to the evaporator(s) is subcooled further by 13 K so that the liquid temperature T₇ reaches approx. 6 °C.

So from an energy point of view, the suggested modification is a very good idea.
Exercise 11: Liquid flow in pipes (pressure drop and heat transfer)

A pipe with R404A as pure liquid is to be led through a room with the temperature 35 °C. The relative humidity of the air in the room is 80 %. The pressure of the refrigerant corresponds to a saturation temperature of 25 °C and the liquid is subcooled 1 K. The mass flow rate is 0.35 kg/s and the length of the pipe is 15 m.

1. Find an acceptable pipe diameter and insulation thickness, making it possible to have a subcooling of 0.8 K in the pipe exit.

The liquid passes through a suction gas heat exchanger and is cooled to 15 °C. Thereafter the refrigerant pipe is led through the same room for a distance of 10 m.

2. Is the pipe still well enough insulated? Does water vapor condense on its surface?
Exercise 11: Suggested solution

Use the CoolTool with the title “Pressure drop and heat transfer for liquid flow in pipes”. You find it in the program group “CoolTools: Auxiliary”.

It is represented by the following icon �ToBounds!

Enter the relevant values in the cycle-specification subdiagram window.

1. Try different pipe diameters until you obtain a suitable velocity of the refrigerant and thereby reasonable pressures drop. A copper pipe with the diameter of 1 1/8” is adequate. Then try adjusting the insulation thickness in order to maintain a suitable subcooling. 10 mm of Armaflex will ensure a subcooling of 0.83 K in the outlet.

2. Enter the new values. The surface temperature of the pipe drops below the dew point temperature of the air - water vapour will condense on the insulation surface. An insulation thickness of 20 mm will increase the surface temperature sufficiently (above the dew point temperature) to avoid the condensing of water vapour.
Exercise 12: Gas flow in pipes (pressure drop and heat transfer)
A pipe with R404A as gas flows through a room with a temperature of 25 °C and a relative humidity of 40 %. The pressure of the gas in the pipe inlet is –35 °C and the gas is superheated 5 K. The dimensioning mean velocity is 11 m/s and the pipe is 10 meter long.

1. Find a suitable pipe when the flow is 40 m³/h. Check the pressure drop.

2. Select an appropriate insulation thickness so that the pipe doesn’t “sweat”
A non-isolated pipe runs through the same room. The gas has a pressure of 35 °C and a temperature of 50 °C. The volume flow is 30 m³/h and the pipe is a 1 1/8” cobber tube which is 10 meters long.

3. What will the temperature drop be?
Exercise 12: Suggested solution

Use the CoolTool with the title “Pressure drop and heat transfer for gas flow in pipes”. You find it in the program group “CoolTools: Auxiliary”.

It is represented by the following icon

1. Try different pipe dimensions until the volume flow is above 40 m$^3$/h. A pipe of 1 5/8” can be used.

The pressure drop is about 0.3 K, which is acceptable.

2. Try different insulation thickness. 10 mm Armaflex will ensure a surface temperature of 13.3 °C and the dew-point temperature is about 10.5 °C.

3. Using the specified values gives a temperature drop of 0.8 K.
Exercise 13: Air cooler - Cooling and dehumidification of moist air
You are dimensioning a refrigeration plant, which will be used for cooling and dehumidifying air before it is blown into a room.

The flow of humid air is 10000 m$^3$/h and in the dimensioning condition the temperature is 23 °C, the relative humidity is 65 % and the pressure is 101.325 kPa (normal atmospheric pressure). The air flow is cooled by an air cooler with a surface temperature of 6°C and the supply temperature is 10 °C.

1. What is the total cooling demand for cooling and dehumidifying the air flow? What is the sensible heat ratio (SHR) and how much water is removed from the air (in kg/h).
2. You learn that, because of pressure drop in the channels that leads the air flow to the cooler, the pressure is no longer 101.325 kPa. Actually it can be as low as 95 kPa. Does the low pressure change anything in the process?
3. It turns out that the ordered refrigeration plant cannot deliver the required dimensioning capacity. At a surface temperature of 6 °C the system can maximum deliver 60 kW. What will the supply temperature be in this case?
Exercise 13: Suggested solution

Use the CoolTool with the title “Air cooler - Cooling and dehumidification of moist air”. You find it in the program group “CoolTools: Auxiliary”.

It is represented by the following icon:

Question 1:

Using the given values, you’ll get the following results:

\[
\begin{align*}
Q_c &= 77.73 \text{ kW} \\
\text{SHR} &= 55.5 \% \\
\dot{m}_{\text{water}} &= 50.46 \text{ kg/h}
\end{align*}
\]

Question 2:

By changing the pressure to 95 kPa, the cooling demand changes to 76.05 kW (unchanged volume flow) and SHR changes to 53.9 \%.

Question 3:

In this tool, the cooling capacity is only an output, so the 60 kW cannot directly be entered. Instead you have to try different values of the supply (outlet) temperature until the cooling demand is 60 kW. A temperature of about 13.1 °C will give the correct result.
Exercise 14: Cooling demand for cold room

Calculate the cooling demand for a cold room using the following data:

- The temperature in the room should be -27 °C, and the dimensioning ambient temperature is 23 °C.
- The walls have a k-value of 0.3 W/(m²-K).
- The floor has a k-value of 0.4 W/(m²-K).
- The ceiling has a k-value of 0.25 W/(m²-K).
- The dimensions of the room (L x W x H) is (60 m x 10 m x 6 m)

To account for sun on walls and roof, the ambient temperature can be raised (by an appropriate temperature of your choice)

The air is exchanged only by door openings corresponding to 1.5 times per day.

There is no cooling or freezing of goods.

The internal load is 2 persons. The lightening is approx. 20 W/m². To avoid freezing the ground, floor heating of approx. 20 W/m² is installed. The evaporator fans use 5 kW and other equipment use 2 kW.

The evaporators are defrosted by demand but no more than 2 at a time.

1. What is the cooling demand of the room?
2. What is the change in cooling demand if the air exchange is changed to 400 m³/h?
Exercise 14: Suggested solution

Use the CoolTool with the title “Cooling demand for a cold room”. You find it in the program group “CoolTools: Auxiliary”.

It is represented by the following icon

If the following dimensioning ambient temperatures are used:

- Walls: 30°C
- Floor: 10°C
- Ceiling: 40°C

Then the cooling demand is about 71 kW.

The relative humidity of the room will be close to 100%, lights and floor heating can be added to a total value of heat per square meter and as the room runs 24 hours, there is no need for compensating the dimensioning load for the defrost (the room will catch up if a defrost should occur at the dimensioning load).

If the air exchange changes to 400 m³/h, the demand changes to about 76 kW.
Exercise 15: Transient cooling of goods in a refrigerated room

You have been given the task of dimensioning a small cold storage room for 100 boxes of beer. The beer should be cooled from a temperature of 25 °C to 5 °C in no less than 8 hours. The owner of the plant is an environmentalist and demands that R717 (ammonia) is used as refrigerant.

The following parameters have to be determined:

- The displacement of the compressor (m³/h)
- The UA-value of the evaporator
- The UA-value of the condenser
- The UA-value of the room (heat transfer through building element from the surroundings)

You can assume that it is the capacity of the beers that govern the dynamics of the room temperature.

The UA-values of the heat exchangers has to be dimensioned so that the corresponding temperature differences are approx. 10 K.

What will the total compressor energy consumption (in kWh) be for cooling down the 100 boxes of beer, and what will the average COP be?
Exercise 15: Suggested solution

Use the program for calculation of transient cooling of a room or an object. You will find it in the program group “Dynamic”. It is represented by the following icon.

As an introduction try to get familiar with variables specified in the tabs: Initial, Control, Load, Evaporator, Compressor and Condenser

Select NH₃ from the list of refrigerants with is accessible once the "Initial" tab is activated. Type in an initial temperature of 25 °C in this tab also.

The mass and the heat capacity of the object to be cooled can be specified in the tab "Load". The mass of 100 boxes of beer corresponds to approx. 1100 kg of water having a \( c_p \) of 4.2 kJ/(kg\(^\circ\)K).

As it is possible to operate with different surrounding temperatures for the condenser and the load (room), these have to be specified individually. Both should be 25 °C and constant. The latter is achieved by setting the amplitude to 0 (zero) for the 24-hours sine wave shaped reference curve.

In the tab called “Control” choose the maximum temperature to be 6 °C and the minimum temperature to be 4 °C.

The superheat can be assumed to be 5.0 K, while the subcooling could be 2.0 K.

Click "Start" to activate the simulation. Select which variables to show in the plot window. Try varying the displacement of the compressor and the respective UA-values such that \( T_{LOAD} \) has reached 5 °C after approx. 8 hours.

The following values of the parameters lead to a reasonable cooling time:

- Load UA-value = 75 W/K (Heat transmission to room from the surroundings)
- Evaporator UA-value = 400 W/K
- Condenser UA-value = 500 W/K
- Compressor displacement of 4.5 m³/h (isentropic and volumetric efficiencies, and heat loss are kept as the default values)

It can be very instructive to recognize that a larger evaporator leads to a smaller compressor and vice versa.

In the tab called "Output" integrated values for energy consumption and COP are available. Before you note these make sure that the end time of your simulation is approx. 8 hours ("initial" tab). In this case the energy consumption of the compressor will be approx. 6.8 kWh and the average COP will be approx. 5.1.
Concepts, shortcuts, and other hints

Concepts
In some contexts two different COP’s are defined: COP and COP*.

In both cases the actual power consumption of the compressor is used. The difference arises from the definition of the "useful cooling". For COP it is the cooling-effect transferred in the evaporator which is used, whereas for COP* a cooling-effect based on the change of enthalpy from the compressor inlet to the condenser outlet is used. In the latter case a heat up in the suction line will increase the calculated COP. COP* can be interpreted as a calculation seen from the compressors point of view, as it can't distinguish between a heat input in the evaporator and a heat input in the suction line.

Screen
A resolution of 800 x 600 pixels or better is recommended. All EESCoolTools are designed for a screen resolution of 800 x 600.

EESCoolTools
The main diagram window is activated by pressing Ctrl+D. This is also used when returning from a subdiagram window.

All inputs are indicated by boxes: □

Pressing F2 activates calculations. Before this is done all output variables will be greyed out or won’t have any values. This is represented by asterisks (****) or (????).

The numerical solver seeks to reduce the maximum residual below a certain limit (default $10^{-6}$).

If you already have obtained a solution with one set of input values, it might be advantageous to update the values of start guesses before you change some of the input values. Pressing "Ctrl+G" does this.

When printing diagram windows there is a possibility to select the individual diagrams. This is done in the following way. In the print menu you first deselect the diagrams and the select them again (\). Then a menu pops up, where you can choose the specific diagrams you want to print.
Overview of programs in CoolPack

*Programs in Refrigeration Utilities*

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refrigeration Utilities can be used for calculation of refrigerant properties and creation of high quality property plots</td>
<td></td>
</tr>
<tr>
<td>Heat transfer fluids is a small handy program used for calculating thermodynamic and thermophysical (transport) properties of heat transmission-fluids (secondary fluids).</td>
<td>NaCl</td>
</tr>
<tr>
<td>Refrigerant calculator is a small handy program used for calculating thermodynamic and thermophysical properties of refrigerants.</td>
<td>R22</td>
</tr>
</tbody>
</table>

*Programs in EESCoolTools: Cycle analysis (C-Tools)*

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-Stage Cycle analysis: Dry expansion evaporator</td>
<td></td>
</tr>
<tr>
<td>One-Stage Cycle analysis: Flooded evaporator</td>
<td></td>
</tr>
<tr>
<td>One-Stage Cycle analysis: Two systems with common condenser</td>
<td></td>
</tr>
<tr>
<td>One-Stage Cycle analysis: Two systems, cooling of liquid in low temperature system</td>
<td></td>
</tr>
<tr>
<td>Two-Stage Cycle analysis: Cooling of suction gas by liquid injection</td>
<td></td>
</tr>
<tr>
<td>Two-Stage Cycle analysis: Open intercooler, flooded evaporators</td>
<td></td>
</tr>
<tr>
<td>Two-Stage Cycle analysis: Closed intercooler, flooded evaporators</td>
<td></td>
</tr>
<tr>
<td>One-Stage Cycle analysis: Transcritical cycle with CO₂</td>
<td></td>
</tr>
<tr>
<td>Two-Stage Cycle analysis: Transcritical cycle with CO₂</td>
<td></td>
</tr>
<tr>
<td>Two-Stage Cycle analysis: Cascade system</td>
<td></td>
</tr>
</tbody>
</table>

*Programs in EESCoolTools: Design*

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design package for One-Stage systems with DX-evaporators, containing:</td>
<td></td>
</tr>
<tr>
<td>• One-Stage Cycle analysis</td>
<td></td>
</tr>
<tr>
<td>• System dimensioning: Calculation of component sizes</td>
<td></td>
</tr>
<tr>
<td>• System energy analysis: Calculation of operating conditions</td>
<td></td>
</tr>
<tr>
<td>• System energy analysis: Calculation of operating conditions – multiple parallel coupled compressors and evaporators</td>
<td></td>
</tr>
</tbody>
</table>
### Programs in EESCoolTools: Evaluation (E-Tools)

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Energy analysis of a one-stage system with DX-evaporators.</td>
<td></td>
</tr>
<tr>
<td>- Constant compressor capacity</td>
<td></td>
</tr>
<tr>
<td>Energy analysis of a one-stage system with DX-evaporators.</td>
<td></td>
</tr>
<tr>
<td>- Stepwise variable compressor capacity</td>
<td></td>
</tr>
</tbody>
</table>

### Programs in EESCoolTools: Auxiliary Tools (A-Tools)

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor</td>
<td></td>
</tr>
<tr>
<td>UA-value for an evaporator</td>
<td></td>
</tr>
<tr>
<td>UA-value for a condenser</td>
<td></td>
</tr>
<tr>
<td>Cooling and dehumidification of moist air</td>
<td></td>
</tr>
<tr>
<td>Pressure drop and heat transfer in gas pipes</td>
<td></td>
</tr>
<tr>
<td>Pressure drop and heat transfer in liquid pipes</td>
<td></td>
</tr>
<tr>
<td>Thermodynamic and thermophysical properties of a refrigerant</td>
<td></td>
</tr>
<tr>
<td>Comparison of three refrigerants using a one-stage cycle</td>
<td></td>
</tr>
<tr>
<td>Calculation of cooling demand for a refrigerated room</td>
<td></td>
</tr>
<tr>
<td>Calculation of cooling demand for liquid coolers</td>
<td></td>
</tr>
<tr>
<td>Calculation of cooling demand for refrigerated display cabinets</td>
<td></td>
</tr>
<tr>
<td>Calculation of cooling demand for an air-conditioned room</td>
<td></td>
</tr>
<tr>
<td>Calculation of properties for humid air</td>
<td></td>
</tr>
<tr>
<td>Calculation of Life Cycle (New Tool in version 1.45)</td>
<td></td>
</tr>
</tbody>
</table>

### Programs in Dynamic

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>General model for the cooling of a room with goods (ON/OFF-control of compressor)</td>
<td></td>
</tr>
</tbody>
</table>